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O B J E C T I V E S After completing this lesson, you will be able to:

1. Start PowerPoint.
2. Explore PowerPoint.
3. Use text placeholders.
4. Use tabs and views.
5. Name and save a presentation.
6. Run a slide show.
7. Print slides and handouts.
8. Close a presentation and exit PowerPoint.

Estimated Time: 2 hours

Microsoft PowerPoint is a powerful but easy-to-use presentation graphics
program you can use to create professional-quality presentations.

PowerPoint can be used in a variety of settings by people in many different career
fields. For example, a day care worker may develop a presentation showing par-
ents pictures of their children in all of the year’s activities, or a minister may uti-
lize PowerPoint to display notes on the sermon or display song lyrics for the
congregation. An instructor may use it for notes for a lecture to help keep the stu-
dents focused and their notes organized, or a hotelier may develop a presentation
to help market their hotel at conferences and meetings. PowerPoint is also an ef-
fective tool for creating flyers and other printed products because of its versatile
drawing and layout tools.

MICROSOFT OFFICE
SPECIALIST

A C T I V I T I E S
In this lesson:

PP03S-1-2
PP03S-4-1
PP03S-4-4
PP03S-4-6
PP03S-4-7

See Appendix.

Point out to students that the learning
objectives show what they will learn in
the lesson. Each heading in the lesson
correlates to a learning objective.
Required Files:
ThreeYr1.ppt

P
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R
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Teaching Resources:
This text is supported by Classroom
Presentations in a PowerPoint format.
For this lesson, use PowerPoint
Classroom Presentation 1.

T
E
A
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H
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This lesson begins with an overview of many PowerPoint features and will
help you become accustomed to the application window.

Starting PowerPoint
There are several ways to start PowerPoint, depending on your system setup and
your personal preferences.

● Use the Start button on the Windows taskbar, select Microsoft
Office PowerPoint 2003.

● Use the Start button on the Windows taskbar, select the All Programs
menu, then select Microsoft Office, Microsoft Office PowerPoint 2003.

● Double-click the PowerPoint shortcut icon if one appears on your
Windows desktop.

E X E R C I S E 1-1 Start PowerPoint

When you start PowerPoint, a new blank presentation automatically appears,
ready for you to start inserting text, graphics, or multimedia elements.

NOTE: If you are unfamiliar with Windows, refer to the “Windows Tutorial” at
the Professional Approach Online Learning Center at www.mhteched.com/pas.

1.1. Turn on your computer to load Windows.

2.2. Click the Start button on the Windows taskbar and point to Programs.
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Objective 1

bIn PowerPoint Classroom Presentation 1.

b

FIGURE 1-1
Starting PowerPoint

from the
Windows taskbar

Start button
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NOTE: Windows provides many ways to start applications. If you have
problems, ask your instructor for help.

3.3. On the Programs submenu, click Microsoft PowerPoint. In a few seconds, the
program is loaded and the PowerPoint window appears.

NOTE: The pane on the right of the screen is the task pane. The task pane is
designed to save you time by bringing options you regularly need close to your

workspace so you can be more efficient. The next exercise will give you more information
on the task pane.

4.4. If your screen does not look like Figure 1-2, click the Normal View button
in the lower-left corner of the window or ask your instructor for

assistance.

E X E R C I S E 1-2 Work with Task Panes

When you choose certain commands as you are working, specialized task panes
appear on the right side of your window. They provide commonly used com-
mands related to the action you are currently performing.

NOTE: If the task pane is not displayed on the right of the screen, from the
View menu choose Task pane.
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1

1Explain to students
that their desktop

might look different from
the desktop displayed in
the figure because of
differences in loaded
applications.

FIGURE 1-2
PowerPoint

opening window

b 2 3

Normal View button

Task pane

4

bIn PowerPoint Classroom
Presentation 1. 2It is possible that students will not see the same layout as shown

in Figure 1-2. If you like, you can set the Default opening view
by choosing Options from the Tools menu and then choosing the View
tab. At the bottom of the dialog box under Default view, choose
“Normal – Outline, Notes and Slide” from the list box and click OK.
Alternatively, you can tell students to click the Normal View button in
the lower-left corner of the screen, just above the Draw button.

3In some cases, this
book assumes that

students have some basic
familiarity with Windows
applications.
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1.1. Click the Other Task Panes
arrow . A drop-down list
appears and you can see the
number of other task panes
that are available.

2.2. Choose Slide Layout. The task
pane changes to show options
for how slide content can be
arranged. You will use this task
pane in Lesson 2.

3.3. Click the Back button at the
top of the Slide Layout task
pane. The Getting Started task
pane reappears. The Back
button and Forward button

enable you to return to
recently used task panes.

4.4. Click the task pane’s Close button . This removes the task pane from
the screen.

5.5. Click View on the menu bar, and then click Task Pane. The last task pane
you used is displayed again.

E X E R C I S E 1-3 Open an Existing Presentation

The opening PowerPoint window displays a blank slide, ready for you to add
text, images, and additional slides. In Lesson 3 you will create a presentation
using this blank slide.

In this exercise you open an existing PowerPoint presentation. The presenta-
tion was created especially for this lesson to give you an overview of many of
PowerPoint’s features.

1.1. From the Getting Started task pane in the Open section, choose More to
display the Open dialog box.
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4Your students most likely do not have the task
pane displayed in their PowerPoint window at

this time. They will learn how to display it in the next
exercise.

FIGURE 1-3
Working with

task panes

b

Forward and
Back buttons

Other Task Panes
arrow

Task pane Close
button

bIn PowerPoint Classroom Presentation 1.
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2.2. Click the down arrow next to the Look in box and choose the appropriate
drive and folder for your student files according to your instructor’s
directions.
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1You might want to review the Open dialog box buttons listed here.
You might also want to review the buttons on the Places bar (My

Recent Documents, Desktop, My Documents, My Computer, My Network
Places). These buttons are helpful for locating and viewing files. The same
buttons appear in the Save As dialog box. If you have loaded all student
files into a folder on a hard disk or network, you might want to show
students how to place this folder in the “My Documents” list for easy access.

1

BUTTON NAME PURPOSE

Back Enables you to return to a folder or place you previously opened
while working in this dialog box.

Up One Level Moves up one level in the hierarchy of folders or drives on your
computer or on computers connected to your computer.

Search the Web Opens the Search page of your Internet browser (if you are
online) so that you can search the Web for information.

Delete Deletes a file or folder.

Create New Folder Enables you to create a new folder to organize your files.

Views Opens a menu of view options for displaying files and file icons.

Tools Opens a menu of other file utilities, such as finding a file,
renaming a file, and adding a file or folder to the Favorites folder.

TABLE 1-1 Buttons in the Open Dialog Box

FIGURE 1-4
Files listed in the

Open dialog box

Scroll bar

Views button

Click to choose
drive or folder.

b

bIn PowerPoint Classroom Presentation 1.
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NOTE: Your instructor will advise you where to locate the files for this
course. For more information about working with files, folders, and directories

in Windows, refer to “File Management” at the Professional Approach Online Learning
Center at www.mhteched.com/pas.

3.3. When you locate the student files, click the arrow next to the Views button
in the Open dialog box to display a menu of view options.

4.4. Choose List to list all files by name.

5.5. Click the Views button again and choose Preview to get a quick look at a
presentation’s first slide before opening it.

6.6. Locate the file ThreeYr1 (use the scroll bar if you need to) and click once to
select the file.

7.7. Click Open. (You can also double-click the file’s name to open it.)
PowerPoint opens the file in Normal view.

NOTE: The presentations you create in this course relate to the Case Study
about Good 4 U, a fictional restaurant (see pages 1 through 4).

Exploring PowerPoint
If you are already familiar with other Microsoft Office programs, you’ll feel right
at home with PowerPoint. Although a number of new buttons appear in the
PowerPoint window, it’s easy to recognize similarities to Microsoft Word and
Microsoft Excel.
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1Make sure students know where files for this
course are located. You can load student files

on a hard disk or on a network. If this has not already
been done, you may load the files from the Student
disk to a location where the students can access them,
or they can load them from the CD that accompanies
the text.

2The presentation name might appear as
“ThreeYr1[Read Only]” in the title bar.

Explain to students the purpose of this read-only
protection (to preserve the original file). Make sure
this protection is applied to all loaded student files.

Objective 2

FIGURE 1-5
Main features in

PowerPoint’s
Normal view

Outline and
Slides pane

View buttons

Status bar

Title bar

Menu bar

Slides tab

Outline tab

Scroll bar

Notes pane

Task pane

Slide pane

Scroll bars

b

1

bIn PowerPoint Classroom Presentation 1.

2

Drawing toolbar

Formatting toolbarStandard toolbar
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E X E R C I S E 1-4 Identify Parts of the PowerPoint Window

The first step to getting familiar with PowerPoint is to identify the parts of the
window you’ll be working with in this course, such as menus, toolbars, buttons,
tabs, and panes. There are many different objects in the PowerPoint window.
ScreenTips help you identify these objects. AScreenTip is the box displaying an ob-
ject’s name that appears under a button or other object when you point to it.
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PART OF WINDOW PURPOSE

Title bar Contains the name of the presentation.

Menu bar Displays the names of menus you use to perform various tasks. You can open
menus by using the mouse or the keyboard.

Toolbars Rows of buttons that give instant access to a wide range of commands. Each
button is represented by an icon and accessed by using the mouse. PowerPoint
opens with the Standard and Formatting toolbars displayed in abbreviated form
on one line at the top of the window.

Drawing toolbar The drawing toolbar is displayed at the bottom of the window and gives access
to buttons to add shapes, clip art, WordArt, change colors, and design aspects
of objects.

Outline and
Slides pane

The area that can display either an outline of the presentation’s text or
thumbnails—miniature pictures—of the presentation’s slides. You choose either
Outline or Slides by clicking the appropriate tab. (If this pane is not displayed,
click the Normal View button.)

Slide pane The area where you create, edit, and display presentation slides.

Notes pane The area where you can add presentation notes for either the presenter or
the audience.

Task pane An area that can appear on the right side of the PowerPoint window,
displaying a list of commands that are relevant to the task on which you
are currently working.

Scroll bars Used with the mouse to move a slide view or outline text right or left and up
or down. You can also use the vertical scroll bar to move from slide to slide.

View buttons Three buttons located in the lower-left corner of the window. You use these
buttons to switch between Normal view (the default), Slide Sorter view, and
Slide Show.

Status bar Displays information about the presentation you’re working on.

TABLE 1-2 Main Parts of the PowerPoint Window
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1.1. Use the mouse to point to the Normal View button in the lower-left
corner of the window. PowerPoint displays the button’s ScreenTip. If
this button is not already selected, click it with the left mouse button.

2.2. Point to other buttons in the window to
identify them by name.

3.3. If the Office Assistant is displayed, click it with
the right mouse button to display a shortcut
menu. Choose Hide on the shortcut menu.

TIP: If you’d prefer to display the Office
Assistant, click Help on the menu bar and choose

Show the Office Assistant. When the Office Assistant is
displayed, you can also right-click it and use the shortcut
menu to choose another animated character.

E X E R C I S E 1-5 Work with Menus and Toolbars

You access PowerPoint commands through many different methods:
● Choose from a menu.
● Use toolbar buttons.
● Choose from task pane items.

1.1. Point to View on the menu bar and click the left mouse button to open the
menu. PowerPoint displays a short version of the View menu with the most
commonly used View menu commands.

2.2. Expand the menu either by keeping it open for a few seconds or by pointing
to the arrows at the bottom of the menu. Notice the additional commands
on the expanded menu.

NOTE: PowerPoint’s short menus are adaptive—they change as you work,
listing the commands you use most frequently.

3.3. To close the menu, click View or a blank area of the window, or press [Esc].

4.4. Open the View menu again and point to Toolbars. On the Toolbars submenu,
the Task Pane and three toolbars should be selected: Standard, Formatting,
and Drawing. If one of these does not have a check mark, click it on the
Toolbars submenu to select it. (See Figure 1-7 on the next page.)

5.5. Close the View menu. Open the Tools menu and expand it. Without clicking
the mouse button, move the pointer left to Format on the menu bar. Continue
moving the pointer left on the menu bar until you display the Edit menu.
Close the Edit menu.
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1

1To display a ScreenTip, remind
students they must point to the

toolbar button and hold the pointer
still. PowerPoint doesn’t display tips
unless the mouse hasn’t moved for a
second or so.

FIGURE 1-6
Identifying a button

bIn PowerPoint Classroom Presentation 1.

b

2In step 3, you might want
students to leave the Office

Assistant activated.
3In step 4, point out that displayed

toolbars appear on the Toolbars
menu with a check mark. If you choose a
toolbar with a check mark from the menu,
you “uncheck” the toolbar and hide it
from view.

3

2

P:\010Comp\PAS\444-0\ch01.vp
Thursday, May 27, 2004 10:30:14 AM

Color profile: Generic CMYK printer profile
Composite  Default screen



TIP: PowerPoint provides several ways to complete tasks: a menu shows
which commands have corresponding toolbar buttons or keyboard shortcuts.

For example, you can save a document by choosing File on the menu bar and then
clicking Save, by clicking the Save button on the Standard toolbar, or by holding
down [Ctrl] and pressing [s] (this is shown as [Ctrl]+[s]).

6.6. Point to several buttons on the Standard toolbar and identify them by using
the ScreenTip feature.

7.7. Click the Toolbar Options button at the end of the Standard toolbar to see
the rest of this toolbar’s buttons. Move the mouse pointer over any button
to identify it.

PAS/CAS / PowerPoint 2003 / Graves / TE 225469-6/SE 225444-0 / Lesson 1
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FIGURE 1-7
Displaying

menu options

b

Point here to expand menu.

Toolbars submenu

b

bIn PowerPoint Classroom Presentation 1.

FIGURE 1-8
Side-by-side

toolbars

Standard toolbar Formatting toolbar

Toolbar Options
button. (Click for
more Standard
toolbar buttons.)

Toolbar Options
button. (Click for
more Formatting
toolbar buttons.)
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8.8. Click the Toolbar Options button at the end of the Formatting toolbar to
see additional toolbar buttons for the Formatting toolbar. Press [Esc] to hide
the additional buttons.

NOTE: When you click the Toolbar Options button and use one of
these “hidden” toolbar buttons, the button will move off the “More Buttons”

list and onto the regular toolbar. PowerPoint’s toolbars are adaptive—they change as
you work, displaying the buttons you use most frequently.

E X E R C I S E 1-6 Work with Docked and Floating Toolbars

Sometimes it’s convenient to move a toolbar to another location in the window—
so you don’t need to move your mouse back and forth when you’re using the
same tool repeatedly. Toolbars are either docked or floating. A docked toolbar is at-
tached to one of the edges of the program window. A floating toolbar is not at-
tached; you can drag its title bar to freely move it wherever you want. You drag a
title bar by pointing to it and then holding down the left mouse button while you
move the mouse.

1.1. Point to the move handle on the left end of the standard toolbar. When
the four-pointed arrow appears, drag the toolbar down until it appears
to be in the middle of your window. The Standard toolbar is now a floating
toolbar.

2.2. Point to the bottom edge of
the floating toolbar. When a
vertical two-pointed arrow
appears, drag it up or down
to change the shape of the
toolbar.

3.3. Point to the Standard
toolbar’s title bar and drag
it to a new location on your
window.

4.4. Double-click the Standard
toolbar’s title bar. The toolbar
returns to its original place
next to the Formatting toolbar.
It is once again docked.

TIP: To display both the Standard and Formatting toolbars on separate
rows, right-click the Toolbar Options arrow and choose Customize (or from the

View menu choose Toolbars and then Customize). From the Options tab, select Show
Standard and Formatting toolbars on two rows. Click Close. Now all the buttons are
easier to use.
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1Until students become used to Windows and
the method of moving among menus, they

might accidentally click the mouse button. This
might also happen when they move the pointer
over a toolbar button. You might have to instruct
students how to close a dialog box or stop and undo
a procedure.

1

2Point out that some toolbar
buttons appear dimmed or

gray. For example, the Cut button is
dimmed unless something is selected.

FIGURE 1-9
Moving a toolbar

Title bar

Four-pointed arrow

Move handle

Floating toolbar

2 b

bIn PowerPoint Classroom
Presentation 1.

3

3If your lab is not set up to
display the Standard and

Formatting toolbars on separate rows,
remind students to complete the steps
in the tip to allow both toolbars to be
displayed in their entirety.
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E X E R C I S E 1-7 Move from Slide to Slide

PowerPoint provides several ways to move from slide to slide in a presentation:
● Use the mouse to drag the scroll box.
● Use the mouse to click the Previous slide or Next slide buttons.
● Use the [Page{Up] and [Page{Down] keys on the keyboard.

1.1. Drag the vertical scroll box on the Slide pane to the bottom of the scroll
bar. Notice the box that displays slide numbers and slide titles as you drag.
When you release the mouse button at the bottom of the scroll bar, slide 7
appears in your window. Notice the heavy border around the slide 7
thumbnail in the Slide pane. This identifies it as the current slide.

2.2. Drag the scroll box up to display slide 6. Notice that the slide number is
indicated on the left side of the status bar.

3.3. Click the Previous Slide button at the bottom of the vertical scroll bar
several times to move back in the presentation. Use the Next Slide button

to move forward.

4.4. As an alternative to clicking the Next Slide button and the Previous Slide
button , press [Page{Down] and [Page{Up] on your keyboard several times. Use
this method to move to slide 2. Check the status bar for the slide number.
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FIGURE 1-10
Moving from
slide to slide

Current slide

Slide number
indicator

Box displaying slide
number and title

Vertical scroll box

Previous Slide button

Next Slide button

b

bIn PowerPoint Classroom Presentation 1.

1

1In this exercise students are asked to
drag a screen element. If students are

unfamiliar with dragging, you might take this
opportunity to demonstrate how to drag an
element and ask students to practice.

2

2Another way to move from slide to slide is to
click above or below the scroll box on the

vertical scroll bar or use the left and right arrow keys.
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Using Text Placeholders
Editing text in PowerPoint is very similar to editing text in a word processing pro-
gram. You click an I-beam to position the insertion point where you want to key new
text. An I-beam is a mouse pointer in the shape of an uppercase “I.” An insertion
point is a vertical blinking bar indicating where text you key will be placed. You
can also drag the I-beam to select existing text. The keys [Enter], [Delete], and [Backspace]
work the same way as in a word processing program.

It is important to understand that you activate a placeholder when you click the
I-beam in it, making it ready to accept text.

E X E R C I S E 1-8 Edit Text on a Slide

Text on the slide is contained in text placeholders. Placeholders are used for title text
(the text that usually appears at the top of a slide), body text (text in the body of a
slide), and other objects, such as pictures. Placeholders help keep design layout
and formatting consistent within a presentation.

Body text often contains bullets and is sometimes called “bulleted text.” Bullets
are small dots, squares, or other symbols placed to the left of each item in a list or
series of paragraphs to add emphasis and readability.

1.1. With slide 2 displayed, click anywhere on the line of text that begins
“Gus Irvinelli.”
Notice the box that surrounds the text. The wide border made up of tiny
diagonal lines indicates that the text box is activated and in edit mode,
meaning you can edit and insert text.

2.2. Without clicking, move the mouse pointer outside the border to the right
and then back inside.
Notice that the pointer changes from an I-beam inside the border to an
arrow pointer outside the border. When the pointer rests on top of the
border, it becomes a four-pointed arrow , which can be used to move the
text placeholder.

3.3. Drag the I-beam across the text “an avid” to select it. (Click to the left of
“an avid,” hold down the left mouse button, drag the I-beam across the two
words, and then release the mouse button.) (See Figure 1-11 on the next page.)

4.4. Key a professional to replace the selected text. (You don’t need to delete
selected text before keying new text.)

5.5. To place the insertion point, click the I-beam to the right of the words
“healthy eating” near the bottom of the slide.
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Objective 3

1Explain to students that if they click when they
see an I-beam, they activate a text box (or text

placeholder) for editing. To deactivate a text box, click
outside the text box—then the pointer is a white arrow.

1
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6.6. To insert a new line, press [Enter]. Notice that a new dimmed bullet appears
at the beginning of the new line.

NOTE: Bulleted text lists the points being made in a slide presentation.
This presentation uses open circle and solid dot bullets. Later in this course,

you will learn how to change bullet shapes and colors.

7.7. On the new blank bullet line, key Make their financial investment grow

8.8. Instead of a title, slide 2 contains an empty text placeholder. Click the
placeholder containing the text “Click to add title.” Then key Where We
Came From

9.9. Click a blank part of the slide area to deactivate the text box. To make sure
you’re clicking a blank area, click when the pointer is a simple arrow, not
an I-beam or a four-pointed arrow.

E X E R C I S E 1-9 Promote and Demote Bulleted Text

When you want to expand on a slide’s main points, you can insert indented
bulleted text below a main point. This supplemental text is sometimes referred
to as a sub-bullet or a level 2 bullet. PowerPoint body text placeholders can have
up to five levels of indented text, but you will usually want to limit your slides to
two levels.

You can demote body text by increasing its indent level, or promote body text by
decreasing its indent level. These changes can be made in two ways:

● Use the promote and demote text buttons.
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1Students might be unfamiliar with the process
of dragging the I-beam to select text. You might

take this opportunity to demonstrate how to do this and
ask the students to practice. If necessary, refer students
to the “Windows Tutorial” at the Professional Approach
Online Learning Center at www.mhteched.com/pas.

1 b

bIn PowerPoint Classroom Presentation 1.

FIGURE 1-11
Selecting text

to edit it

P:\010Comp\PAS\444-0\ch01.vp
Thursday, May 27, 2004 10:30:20 AM

Color profile: Generic CMYK printer profile
Composite  Default screen



● Move the insertion point before the text and press [Tab] to demote or
[Shift]+[Tab] to promote.

1.1. With slide 2 displayed in the Slide pane, move your insertion point after
“Gus Irvinelli” and delete the comma and the blank space after it, then
press [Enter]. Notice that the rest of the line is turned into another bullet
point. Click the Increase Indent button on the Formatting toolbar to
demote text by one level. The text is reduced in size and indented to the
right, and the bullet shape changes.

2.2. Move your insertion point after “Julie Wolfe” and delete the comma and
the blank space after this text, then press [Enter]. With the insertion point
before “a well-known marathon runner,” click the Increase Indent button
to demote the text.

3.3. Click the Decrease Indent button to return the text to its original size
and placement even with Julie Wolfe, then press [Tab] to demote the text
back to the level under Julie Wolfe. Notice the change in the Outline and
Slides pane as you promote and demote text.

NOTE: If you press [Tab] when the insertion point is within the text, you
insert a tab character instead of demoting text.

4.4. Leave the presentation open for the next exercise.

Using Tabs and Views
PowerPoint provides a selection of panes and views to help streamline your work.
Using these various views, you can choose to work on presentation text in outline
format, rearrange slides in Slide Sorter view, or work on an individual slide in the
Slide pane. You can change the way you work by doing any of the following:

● Display or hide the task pane or the Outline and Slides pane.
● Change the information being displayed in the task pane or the Outline

and Slides pane.
● Drag borders to change the size of panes.
● Switch between Normal and Slide Sorter views.

E X E R C I S E 1-10 Use the Outline and Slides Pane

1.1. Point to the right border of the Outline and Slides pane. When the splitter
bar appears, drag it about an inch to the right. The tabs area becomes
wider, and the tab labels change from icons to text.
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2.2. Click the Outline tab. The Outline pane displays the presentation’s text in
outline format.

3.3. Drag the right border of the Outline pane area to the right so that you can
see more of the text. Notice that the changes you made in the Slide pane
are reflected in the outline.

4.4. Scroll down in the outline until you see the text for slide 4.

5.5. Working in the Outline pane,
change each of the years (05, 06,
and 07) to 2005, 2006, and 2007.
The first line, for example,
should read Miami in 2005.
Notice that as you work, your
changes are reflected in the
Slide pane.

NOTE: When you have
several bulleted lists, you can

key them all in outline format if that’s
the way you like to work. You will learn
more about outlines in Lesson 4.

6.6. Click the Close button on the
Outline and Slides pane to hide
it. The Slide pane expands to fill
the space.

7.7. Click the Normal View button
in the lower-left corner of the
window. The Outline and Slides
pane is displayed again.

8.8. Click the Slides tab. The Outline and Slides pane becomes smaller and the
size of the Slide pane increases.

E X E R C I S E 1-11 Use Slide Sorter View

Slide Sorter view displays a window of presentation slide thumbnails, which are
miniature versions of the slides. In this view you can easily rearrange slides or
apply special slide show effects.

1.1. Click the Slide Sorter View button , located in the lower-left corner of the
window to the right of the Normal button.
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FIGURE 1-12
Working with the

Outline and
Slides pane

Splitter bar

Close button

b

Scroll bars

bIn PowerPoint Classroom Presentation 1.

1

1Talk about the possibilities and benefits of using
Slide Sorter. Explain why you might want to use

the Slide Sorter view, for example, to preview each slide
in sequence, to get a snapshot of the entire presentation,
and to move or rearrange slides.
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2.2. On the Standard toolbar, click the down arrow next to the Zoom box and
choose 66%. This should enable you to see all seven slides in this
presentation at the same time.

TIP: Experiment with the zoom percentage. Depending on your screen
resolution, a different percentage might be needed to show all seven slides
at once.

3.3. Double-click slide 1 to return to Normal view.

TIP: The Zoom box is also available in Normal view. If the Slide pane is
active, Zoom changes the magnification of the slide within the Slide pane.

If the Outline and Slides pane is active, Zoom changes that area instead.

Naming and Saving a Presentation
In PowerPoint, presentations are saved as files. When you create a new presenta-
tion or make changes to an existing one, you must save the presentation to make
your changes permanent. Until your changes are saved, they can be lost if there’s a
power failure or a computer problem.

The first step in saving a document is to give it a filename. Filenames can be up
to 255 characters long.
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b

bIn PowerPoint Classroom Presentation 1.

1

1Zoom values on the Print Preview toolbar and
on the Standard toolbar will not necessarily be

the same as shown in this and other figures. When the
Fit zoom setting is chosen, the percentage displayed in
the Zoom box will vary depending on the size of your
monitor, its screen resolution, and the number and size
of the various panes currently displayed.

Objective 5

FIGURE 1-13
Slide Sorter view

Zoom
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Throughout the exercises in this book, your document filenames will consist of
two parts:

● [Your initials], which might be your initials or an identifier your
instructor asks you to use, such as rst

● The number of the exercise, such as 3-1

When you’re working with an existing file, choosing the Save command (or
clicking the Save button on the Standard toolbar) replaces the file on the disk
with the file on which you’re working. After saving, the old version of the file no
longer exists and the new version contains all your changes.

You can give an existing presentation a new name by using the Save As com-
mand. The original presentation remains on the disk unchanged and a second
presentation with a new name is saved on the disk as well.

TIP: The New Presentation task pane has an option labeled From existing
presentation. If you click this link, locate a presentation you want to use, then

click the Create New button, your existing presentation becomes a new presentation
and you can safely save it by using the Save command without fear of overwriting the
presentation on which it is based.

E X E R C I S E 1-12 Create a Folder for Saving Your Files

Before saving a file, you need to decide where you want to save it: in a folder on
your fixed disk drive, on a floppy disk or other removable medium, or on a net-
work drive.

When you save a file, it’s a good idea to create separate folders for specific cate-
gories to help keep your work organized. For example, you might want to create
folders for different projects or different customers. In this course, you will follow
these steps to create a new folder for each lesson’s work before you begin the lesson.

NOTE: Your instructor will advise you of the proper drive or folder to use
when creating your lesson folders.

1.1. Click File to open the File menu and choose Save As. The Save As dialog box
appears. (See Figure 1-14 on the next page.)

2.2. Using the Save in list box, follow your instructor’s directions to navigate to
the location where you should create your folder. If you will be using a
floppy disk, insert a disk into your floppy drive.

3.3. Click the Create New Folder button on the dialog box toolbar. The New
Folder dialog box opens.

4.4. In the Name box, key Lesson 1. Click OK. A yellow folder icon with the
name “Lesson 1” appears in the Save in box.

5.5. Click Cancel to close the Save As dialog box.
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1

1Emphasize the difference between Save and
Save As. This concept is very important for

students who are new to computers.

2

2You will need to tell students which drive/folder
to use to save their files.
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NOTE: Even though you clicked Cancel to close the Save As dialog box,
your new folder has been created. You could have saved your presentation

before closing the Save As dialog box, but you will do that in the next exercise instead.

E X E R C I S E 1-13 Name and Save a Presentation

To name files, you can use uppercase letters, lowercase letters, or a combination of
both. Filenames can also include spaces. For example, you can use “Good 4 U
Sales Report” as a filename.

1.1. Click File to open the File menu and choose Save As to reopen the Save As
dialog box.

2.2. Navigate to the drive and folder where you created your new Lesson 1
folder.

3.3. Double-click the Lesson 1 folder to open it.

4.4. In the File name text box, key [your initials]1-13.

5.5. Click Save. Your document is saved and named for future use. Notice that
the title bar displays the new filename.

Running a Slide Show
Usually the goal of creating a PowerPoint presentation is to present it as a slide
show with computer projection equipment. One of the advantages of running a
slide show from your computer is that you can use special animation effects.
However, if this equipment is not available in the location where you present, you
can use PowerPoint to prepare 35 mm slides or overhead transparencies.
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b

bIn PowerPoint Classroom Presentation 1.

FIGURE 1-14
Creating a

new folder in
the Save As
dialog box

Create New
Folder button

1

1Although a filename can be 255 characters
long, you might want to point out they should

not use more than 20 characters and that their
filenames should be meaningful and easy to find.

2Throughout the text, students are told to save
their files using their initials and the exercise

number. If using initials presents a problem (if, for
example, students with the same initials save files in a
shared folder on a hard drive), assign a unique identifier
to each student saving files within a particular folder.

2

Objective 6
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E X E R C I S E 1-14 Run a Slide Show

One way to start a slide show is to click the Slide Show button . After you begin
running a slide show, PowerPoint provides navigation tools to move from slide
to slide.

1.1. Move to slide 1 if it is not currently displayed. Click the Slide Show button
at the bottom left of the PowerPoint window (next to the Slide Sorter

View button). The first slide in the presentation fills the screen.

2.2. Click the left mouse button to move to slide 2. The left mouse button is one
of many ways to move forward in a slide presentation.

3.3. Press [N] on the keyboard to move to the next slide, slide 3.

TIP: As an alternative to clicking the left mouse button, you can press [N] to
move forward through the slides. [N] means “Next” and [P] means “Previous.”

You can also use the right and left arrow keys and [Page{Down] and [Page{Up] to move
forward and backward in a slide show.

4.4. Press [N] again to move to slide 4, which is titled “Where We’re Going.”

5.5. Using the left mouse button, click anywhere to see a sample of a
PowerPoint text animation. Click twice more to see the remaining
text on this slide.

6.6. Press [Esc] or [-] (Minus) to end the slide show.

E X E R C I S E 1-15 Start a Slide Show from Any Slide

If you had to interrupt a slide show, or you only want to show specific slides, you
can begin a slide show from any slide.

1.1. In Normal view, move to slide 5.

2.2. Click the Slide Show button to resume the slide show from slide 5.

3.3. Click the left mouse button twice to display the text animations on this slide.

Printing Slides and Handouts
Although the primary way of viewing a presentation is usually as a slide show,
you can also print PowerPoint slides, just as you print Word documents or Excel
worksheets. PowerPoint provides a variety of print options, including printing
each slide on a separate page or printing several slides on the same page.

Throughout this course, to conserve paper and speed up printing, you usually
print a handout instead of full-size slides. Ahandout contains several scaled-down
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1At this point in the lesson, you might want to
engage students in a discussion about real-life

uses for presentations. Gather from your class a list of
outside activities, such as clubs, organizations, and
cultural groups to which students belong. Discuss how
they can use PowerPoint to make presentations for
these groups or for their employers.

1

Objective 7
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slide images on each page (1, 2, 3, 4, 6, or 9 to a page), and is often given to an audi-
ence during a presentation.

E X E R C I S E 1-16 Preview a Presentation

The PowerPoint Print Preview feature lets you see what your printed pages will
look like before you actually print them. You can view preview pages in black and
white, grayscale, or color.

1.1. From the File menu, choose Print.
2.2. In the Print range option box, choose All.
3.3. Click Preview in the lower-left corner of the dialog box. The Preview

window opens, showing you how the printed slide will appear on paper.
The Print Preview toolbar is displayed at the top of the window.
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b

bIn PowerPoint Classroom Presentation 1.

TOOLBAR BUTTON NAME PURPOSE

Previous Page Display the previous page to be printed.

Next Page Display the next page to be printed.

Print Open the Print dialog box.

Print What Choose between printing slides, handouts, notes pages,
or an outline.

Zoom Change the magnification in the Preview window.

Landscape Set the printed page orientation to landscape.

Portrait Set the printed page orientation to portrait.

Options Choose from a variety of options and preview them
before printing.

Close Preview Close the Preview window.

TABLE 1-3 Print Preview Toolbar Buttons

FIGURE 1-15
Print Preview

toolbar
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4.4. On the Print Preview toolbar, click the Next Page button . Page 2 of the
printout is displayed.

5.5. Move your pointer to the middle of the slide. Notice that the pointer is in
the shape of a magnifying glass .

6.6. Click the magnifying glass pointer in the center of the slide. The display is
magnified.

7.7. Click again. The display returns to its regular size.

8.8. Close the Preview window.

E X E R C I S E 1-17 Print a Slide

You can start printing in one of the following ways:
● From the File menu, choose Print Preview. After previewing, click the Print

button from the Print Preview window.
● From the File menu, choose Print.
● Press [Ctrl]+[P].
● Click the Print button .

The first method opens the Print Preview window, which you learned in Exer-
cise 1-16. The next two methods open the Print dialog box, where you can choose
printing options. The last method, the Print button , should be used with cau-
tion. It prints a presentation with the most recently used print options and does
not open the print options dialog box. Usually this will result with one slide on a
page for your whole presentation.

1.1. To print the first slide in
your presentation, display
slide 1, open the File menu,
and then choose Print. The
Print dialog box displays
PowerPoint’s default
settings and indicates the
designated printer.

2.2. In the Print range option
box, choose Current Slide.

3.3. From the Print what drop-
down list box, choose
Slides.

4.4. From the Color/grayscale
list box, choose Grayscale.
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1Remind students to use the Print button with
caution as it uses the last chosen print options

and prints a complete presentation one slide per page.
This can consume lots of ink or toner and paper.

FIGURE 1-16
Print dialog box

1 b

bIn PowerPoint Classroom Presentation 1.
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This setting optimizes color slides for a black-and-white printer. (If you
have a color printer, you could choose Color instead.)

5.5. Click OK to start printing.

E X E R C I S E 1-18 Print a Presentation Handout

Printing several slides on a single page is a handy way to review your work and to
create audience handouts. It’s also a convenient way to print class assignments.
You can create handouts in the Print Preview window or in the Print dialog box.

1.1. From the File menu, choose Print Preview. Click the arrow next to the Print
What list box and then choose Handouts (2 slides per page). Two slides are
displayed on the preview page.

2.2. Open the Print What list box again and choose Handouts (9 slides per page).
Now the entire presentation is displayed on one page.

3.3. Click the Landscape button to orient your slides sideways on the page.

4.4. Click the Options button . Make sure the Frame Slides option is selected
to put a line around each slide. Click Scale to Fit Paper to make each slide
slightly larger than if this option was not selected.
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1The Grayscale setting optimizes the look of
color slides for printing on a black-and-white

printer, and saving color ink to cut costs.
2PowerPoint might print faster if you turn off

background printing (Tools, Options, Print tab).

b

bIn PowerPoint Classroom Presentation 1.

1

2

FIGURE 1-17
Choosing printing

options
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5.5. Click the Print button . The Print dialog box opens. You can change
print settings here as well as in the Print Preview window. No further
changes are required now.

6.6. Click OK to print your handout page. After printing, the Preview window
reappears because it was open before the Print window opened.

7.7. Click Close on the Preview toolbar to close the Preview window.

E X E R C I S E 1-19 Choose Print Options

In addition to the options covered previously, there are two options for printing
in black and white. The Grayscale option converts the presentation colors to
shades of gray. The Pure Black & White option converts all colors to either black or
white, eliminating shades of gray. In complex presentation designs, this setting
can be useful.

NOTE: Because the Pure Black & White option simplifies your presentation
graphics, it can sometimes speed up printing time.

The Print dialog box is divided into several areas: Printer, Print range, Copies,
Print what, and Handouts. Each area presents choices that let you print exactly
what you want in a variety of layouts.

1.1. With [your initials]1-13 presentation displayed, click File on the menu bar
and choose Print to open the Print dialog box.

2.2. At the top of the Print dialog box, click the down arrow in the Name box.
This is where you choose another printer, if one is available.

3.3. Follow your instructor’s directions to choose an appropriate printer from
the list.

NOTE: The information below the Name box applies to the selected
printer. For example, “Status” indicates if the printer is idle or currently

printing other documents.

4.4. Under Print range, click Slides and key 1,2 in the text box to print only slides
1 and 2.

TIP: To print consecutive slides, you can use a hyphen. For example, enter
2-4 to print slides 2 through 4. To print a combination of slides, you can key

the range 1,3, 5-9,12 to print slides 1, 3, 5 through 9, and 12.

5.5. Under Copies, in the Number of copies box, key 2. The Collate check box is
selected by default to print the slideshow from beginning to end two times.

6.6. Choose Slides from the Print what drop-down list box.
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1To save printing time and paper,
students are instructed to print

handouts throughout this course instead
of full-page slides (unless they are being
taught other print options).

1
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7.7. If you have a black-and-white printer, choose Grayscale from the Color/
grayscale list box. If you have a color printer, you can choose Color from
the list box.

8.8. Click OK. In the printouts, notice that only slide 2 is numbered.

TIP: You can create a presentation that uses overhead transparencies by
printing your slides on transparency film. Before printing, insert transparency

sheets directly into your printer (choosing the correct type for a laser or ink-jet printer).

9.9. Open the Print dialog box again and set the following options:
● For Print range, choose All to print all slides.
● For Number of copies, key 1
● In the Print what list box, choose Handouts.
● Under Handouts, set the Slides per page to 3.
● From the Color/grayscale list box, choose Grayscale.
● Click the Frame slides check box.

10.10. Click OK to print the presentation handout and close the Print dialog box.

11.11. Click the Save button to resave the presentation, and then close it.

Closing Presentations
and Exiting PowerPoint

After you have finished working on a presentation and saved it, you can close it
and open another file or you can exit the program.

To close a presentation and exit PowerPoint, you can:
● Use the File menu and choose to close or exit.
● Use keyboard shortcuts. [Ctrl]+[W] closes a presentation and [Alt]+[F4] exits

PowerPoint.
● Use the Close button in the upper-right corner of the window.

E X E R C I S E 1-20 Close a Presentation and Exit PowerPoint

1.1. From the File menu, choose Close to close the presentation.

2.2. After printing a presentation, you are usually prompted to save it before
closing. On the message prompt, click Yes to save the presentation again.

3.3. Click the Close button in the upper-right corner of the window to Exit
PowerPoint.

Lesson 1 ■ What Is PowerPoint? POWERPOINT 29

1The Close buttons are the easiest way to close a
presentation or exit the program. Emphasize that

the top Close button (in the Title bar) exits PowerPoint, and
the bottom Close button (on the menu bar) closes the
document window.

1

d Objective 8

dObjective 8 Assignment:
Exercises 1-21 through 1-24 (Skills Review), 1-25
through 1-28 (Lesson Applications), 1-29, 1-30,
and 1-31 (On Your Own) can be assigned after
completing Objective 8.
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USING
ONLINE HELP

Microsoft Office PowerPoint Help is an excellent reference tool for reinforcing
skills presented in a lesson and for finding more information on any PowerPoint
feature.

There are several ways to open the Help window. You can:
● Click Help on the menu bar and then choose Microsoft Office PowerPoint

Help.
● Press [F1] on your keyboard.
● Key a question or topic in the Ask a Question box on the right side of the

menu bar.

TIP: If you choose one of the first two options, the Microsoft Office Assistant
might appear. If you like the Office Assistant, you can key your question in the

Office Assistant balloon. If you don’t like the Assistant, right-click it and choose Hide from
the shortcut menu. To permanently turn off the Assistant, choose Options in the Assistant’s
balloon; then deselect Use the Office Assistant from the dialog box and click OK.

Get acquainted with PowerPoint Help:

1.1. Start PowerPoint, if it’s not already open.

2.2. Click the Ask a Question box on the right side of the menu bar.

NOTE: If this is the first time you are using Help, the Ask a Question box
contains the text “Type a question for help.”

3.3. Key Views and then press [Enter]. A list of Help topics appears.

4.4. Scroll down the list, and then select About PowerPoint views. (See Figure 1-18
on the next page.)

5.5. Drag the Help window’s left border to the left until the Help window fills
about half your screen.

6.6. In the paragraph with the heading “Normal View,” point to the blue text
notes pane. Notice the hand pointer and the underline that appear.
This indicates a link to more information.

7.7. Click notes pane. A definition of the term appears in green text.

8.8. Click anywhere in the green text to make it disappear.

9.9. Scroll down until the blue numbered list of topics appears in the middle of
the Help window. Click any topic to expand it. To compress the topic, click
it again.

10.10. Scroll through and read the entire Help window, expanding all topics and
defined terms as you go. Click the Hide all link at the top of the window
to remove the definitions. Clicking Show all will display them again.

30 POWERPOINT Unit 1 ■ Basic Skills

1

1Encourage students to follow the steps in
“Using Online Help.” Software companies are

increasingly using online help systems—rather than
printed documentation—to train users and assist in
answering user questions.
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11.11. When you have finished, click the Close button in the upper-right corner
of the Help window to close it and return to PowerPoint.

LESSON Summary

➤ Microsoft PowerPoint is a powerful graphics program used to create professional-
quality presentations for a variety of settings.

➤ To start PowerPoint, click Start on the Windows taskbar, point to Programs,
and then select Microsoft PowerPoint from the submenu.

➤ When you perform certain tasks, a task pane with related commands appears
automatically. Display other task panes by clicking the arrow next to the Other
Task Panes button . Hide a task pane by clicking its Close button .

➤ Identify buttons on the PowerPoint window by pointing to them and waiting for
their ScreenTips to appear.

➤ Menus and toolbars do not always show all the available commands. To see more
menu options, point to the menu and wait for it to expand. To see more toolbar
buttons, click the Toolbar Options button .

Lesson 1 ■ What Is PowerPoint? POWERPOINT 31

FIGURE 1-18
Using PowerPoint

Help

Click to see a
definition of blue
underlined words.

bIn PowerPoint Classroom Presentation 1. 1Point out to students that the Ask a Question
box is on the right side of the menu bar. If you

point to it, the ScreenTip displays “Ask a Question.” This
might be confusing because prior to the box’s first use,
it contains the gray text “Type a question for help.”
After using the box, the most recent topic is displayed.

2Encourage students to use the Lesson
Summary to review the important

concepts in the lesson.

11

b

1

2
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➤ Toolbars can be docked or floating. To float a docked toolbar, drag its move handle
. To dock a floating toolbar, double-click its title bar. View, Toolbars, Customize,

Options tab, Show Standard and Formatting toolbar on two rows.
➤ Key and edit text on a slide in the same way as you would in a word processing

program.
➤ Promoting and demoting text on a slide is similar to working with an outline in a

word processing program. When you demote text, you increase its indent. When
you promote text, you decrease its indent.

➤ Use the Slide Show button to run a slide show. A slide show always starts with
the slide that is currently selected.

➤ Choose one of the options in the Print what box in the Print dialog box or in the Print
Preview window to print handouts that contain more than one slide per page.

➤ Printing options provide a variety of ways to print your presentation: as slides,
handouts, notes pages, and other page formats. Printing options are available in
the Print dialog box and in the Print Preview window.
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1Point out that the Command Summary lists a
variety of ways to accomplish a specific task.

Students can decide which method they prefer. Review
keyboard combinations with students. Make sure they
master this skill and understand how it will be
represented in this text.

LESSON 1 Command Summary

FEATURE BUTTON MENU KEYBOARD

Open a presentation File, Open [Ctrl]+[O]

Display Outline and
Slides pane

View, Normal

Display Task pane View, Task Pane

Promote Text [Shift]+[Tab]

Demote Text [Tab]

Zoom View, Zoom

Normal view View, Normal

Slide Sorter view View, Slide Sorter

Next Slide [Page{Down]

Previous Slide [Page{Up]

continues

1
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FEATURE BUTTON MENU KEYBOARD

Slide Show View, Slide Show [F5]

Save File, Save [Ctrl]+[S]

Save with a different
name

File, Save As

Next (Slide Show) Left mouse
button

Right-click, Next [N], [Page{Down]

Previous (Slide Show) Right-click, Previous [P], [Page{Up]

End a slide show Right-click, End Show [Esc] or [-]

Print Preview File, Print Preview

Print File, Print [Ctrl]+[P]

Close a presentation File, Close [Ctrl]+[W] or
[Ctrl]+[F4]

Exit PowerPoint File, Exit [Alt]+[F4]

LESSON 1 Command Summary continued
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Concepts Review
T R U E / FA L S E Q U E S T I O N S

Each of the following statements is either true or false. Indicate your choice by circling
T or F.

T F 1.1. When you start PowerPoint, it automatically displays a blank
presentation.

T F 2.2. Editing text in PowerPoint is similar to editing text in a word
processing program.

T F 3.3. You can demote text by pressing [Shift]+[Tab].

T F 4.4. In the Outline and Slides pane, you can display either slide
thumbnails or outline text, but not both.

T F 5.5. You can edit text in Normal view or in the Outline pane.

T F 6.6. You can display multiple slides as thumbnails in Slide
Sorter view.

T F 7.7. When viewing a slide show, pressing the plus sign moves to
the next slide.

T F 8.8. If you click the Print button , you can choose exactly which
items to print.

S H O R T A N S W E R Q U E S T I O N S

Write the correct answer in the space provided.

1.1. Where on the PowerPoint window are the view buttons located?

Lower-left corner

2.2. What are the names of the three view buttons?

Normal view, Slide Sorter view, and Slide Show

3.3. If the Outline and Slides pane is not displayed, what button can you click
to make it appear?

Normal View button

4.4. What shape is the mouse pointer when you move it over a text box?

I-beam

34 POWERPOINT Unit 1 ■ Basic Skills

e

Concepts Review:
Allows students to check their understanding.
e
Consider using the Test Bank to provide an
additional review of lesson concepts. It may
also be used as an assessment tool.

C
L
O
S
E

•
•
••

••
•
•
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5.5. Which menu and menu option would you use to save a copy of your
presentation under a different filename?

File, Save As

6.6. Name all the ways to use the keyboard for moving to the previous slide
during a slide show.

P, Page Up, Left Arrow

7.7. Which keys can you press to stop a slide show?

Esc, – (minus)

8.8. What is the maximum number of slides you can print on a handout page?

Nine slides

C R I T I C A L T H I N K I N G

Answer these questions on a separate page. There are no right or wrong answers.
Support your answers with examples from your own experience, if possible.

1.1. In this lesson you learned how to display slide thumbnails in the Outline
and Slides pane and also in Slide Sorter view. Which way do you prefer to
view thumbnails and why? What advantages and disadvantages do you
think there are for each option?

2.2. You can produce screen shows, printouts, 35 mm slides, overhead
transparencies, and other presentation media with PowerPoint. Why
would you choose one medium over another? What factors would
influence your decision?

Skills Review
E X E R C I S E 1- 2 1

Start PowerPoint, open a file, identify parts of the PowerPoint window, key and edit
text, and save, print, and close the file.

1.1. If PowerPoint is already open, skip to step 2. Otherwise, start PowerPoint
by following these steps:

a.a. Click the Start button on the Windows taskbar.
b.b. Point to Programs and then point to Microsoft PowerPoint and click it.

Lesson 1 ■ What Is PowerPoint? POWERPOINT 35

Critical Thinking Questions:
Answers will vary, depending on students’
preferences, observations, experiences, and
research.

Skills Review:
Provides guided practice for students.
Objectives are indicated for each exercise.

aExercise 1-21:
Objectives: 1-5, 7-8
Required Files: Answers.ppt
Solution Files: Sol1-21 on Solutions CD-ROM

a

P:\010Comp\PAS\444-0\ch01.vp
Thursday, May 27, 2004 10:30:36 AM

Color profile: Generic CMYK printer profile
Composite  Default screen



PAS/CAS / PowerPoint 2003 / Graves / TE 225469-6/SE 225444-0 / Lesson 1

2.2. Open a presentation by following these steps:

a.a. Click the Open button on the Standard toolbar.
b.b. Choose the appropriate drive and folder, according to your instructor’s

directions.
c.c. Double-click the file Answers.

3.3. Click anywhere on the text “Click to add subtitle” and key your full name.

4.4. Select the two question marks in the text “Exercise 1-??” by dragging the
I-beam across them. Key the number of this exercise.

5.5. To move to slide 2, click the Next Slide button at the bottom of the
vertical scroll bar.

6.6. Key the answers to the questions on slide 2 by following these steps:

a.a. Click to position the insertion point after the word “Answer:” and
press [Spacebar].

b.b. Key the answer.
c.c. Key the answers to the next two questions. Remember, to identify a

toolbar button by name, point to the button. If the button does not appear
on the toolbar, click the Toolbar Options button to locate the button.

d.d. Promote each Answers space by one level. Place the insertion point
before the word Answers and press the Decrease Indent button . Do
this for all three of the answer bullet points.

7.7. Save the presentation as [your initials]1-21 in your Lesson 1 folder by
following these steps:

a.a. From the File menu, choose Save As to open the Save As dialog box.
b.b. Choose your Lesson 1 folder from the appropriate drive and folder,

following your instructor’s directions.
c.c. Key the filename [your initials]1-21 in the File name text box.
d.d. Click Save.

8.8. Print the presentation by following these steps:

a.a. From the File menu, choose Print.
b.b. Choose All in the Print range option box.
c.c. Choose Handouts from the Print what drop-down list.
d.d. Because this is a two-slide presentation, change the Slides per page setting

to 2.
e.e. Choose Grayscale from the Color/grayscale drop-down list.
f.f. Click the Frame slides check box to select it. Click OK.

9.9. Close the presentation by clicking the lower Close button in the upper-
right corner of the PowerPoint window.

36 POWERPOINT Unit 1 ■ Basic Skills
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E X E R C I S E 1- 2 2

Edit text on a slide, save a presentation, run a slide show, then preview and print it.

1.1. Open the file GoodFood.

2.2. Notice on the status bar and on the Outline and Slides pane that this is a
three-slide presentation (slide 1 of 3 now appears). Move to slide 3 by
dragging the vertical scroll box.

3.3. Make corrections to the slide’s text as shown in Figure 1-19.

NOTE: Before making the changes indicated in Figure 1-19, refer to
“Proofreaders’ Marks” at the Professional Approach Online Learning Center

at www.mhteched.com/pas. Proofreaders’ marks are special notations used to mark
up a printed draft with changes to be made before final printing. Some proofreaders’
marks might be confusing if you are unfamiliar with them. For example, a hand-written
“=” indicates that a hyphen is to be inserted.

4.4. Notice on slide 2 that the description of each dish would be more
attractively displayed if they were demoted by one level. Demote the
descriptions by placing the insertion point before the description and
clicking the Increase Indent button .

5.5. Run the presentation as a slide show by following these steps:

a.a. Display slide 1. Click the Slide Show button .
b.b. After slide 1 appears, click the left mouse button to advance to the next slide.
c.c. Click the left mouse button twice more to return to Normal view.

6.6. Save the presentation as [your initials]1-22 in your Lesson 1 folder.

Lesson 1 ■ What Is PowerPoint? POWERPOINT 37

1In the Skills Review and Lesson Applications, students open
presentations that have varying degrees of formatting. Advise

students that they will learn how to apply formatting in the coming
lessons. In addition, students open presentations that are of varying
length (some presentations have only one slide). You might want to
explain the uses for single-slide presentation files, such as flyers,
announcements, and title pages.

1 a

aExercise 1-22:
Objectives: 1-8
Required Files: GoodFood.ppt
Solution Files: Sol1-22 on Solutions CD-ROM

Just Sweet Enough

Carob Pecan Yogurt Cream Pie

This light and fluffy desert has an all-natural grahm cracker

crust, great flavor, and very little sugar.

Key Lime Soufflé

The striking lime flavor is Michelle’s secret. Made from

organic key limes, sweetened with white grape juice, and

thickened with organic egg whites.

FIGURE 1-19

s a

intense chef
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7.7. Print slides 1 and 3 only by following these steps:

a.a. Open the Print dialog box.
b.b. In the Print range area, click Slides and key 1,3 in the text box.
c.c. Choose Slides from the Print what drop-down list, choose Grayscale,

and click OK.

8.8. Close the presentation.

E X E R C I S E 1- 2 3

Work with views and tabs; edit text; run a slide show; and save, preview, and print a
presentation.

1.1. Open the file DressCd1.

2.2. View the presentation’s text in outline format by following these steps:

a.a. If the Outline and Slides pane is not displayed, click the Normal View
button .

b.b. Click the Outline tab.
c.c. Point to the Outline pane’s right vertical border.
d.d. When you see the splitter bar , drag to the right to the center of the

screen to see the text on these slides. Move the splitter bar back to its
original position.

3.3. Click the Slide Sorter View button to view the presentation in Slide
Sorter view.

4.4. Double-click slide 1 in Slide Sorter view to change back to Slide view.

5.5. Create a subtitle on slide 1 by following these steps:

a.a. Click the text placeholder containing the text “Click to add subtitle.”
b.b. Key your name.
c.c. Press [Enter] to start a new line; then key today’s date.

6.6. Run a slide show and navigate within the show by following these steps:

a.a. Click the Slide Show button .
b.b. Advance through the slides by pressing [Page{Down] several times.

7.7. Save the presentation as [your initials]1-23.

8.8. Preview the presentation before printing by following these steps:

a.a. From the File menu, choose Print Preview.
b.b. In the Print What drop-down list, choose Handouts (4 slides per page).
c.c. In the Options drop-down list box, point to Color/Grayscale and then

choose Grayscale.
d.d. Click the Print button .
e.e. In the Print dialog box, make sure the Frame slides option is selected.

Click OK.

9.9. Click Close to close the Print Preview window and then close the presentation.

38 POWERPOINT Unit 1 ■ Basic Skills

a

aExercise 1-23:
Objectives: 1-8
Required Files: DressCd1.ppt
Solution Files: Sol1-23 on Solutions CD-ROM
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E X E R C I S E 1- 2 4

Key text on a slide, save it, and print.

1.1. Open the file SpEvent1.

2.2. Display slide 2.

3.3. Insert a new line of bulleted text by following these steps:

a.a. Click the I-beam to the right of the word “team” at the end of the line
“National In-Line Skate demo team.”

b.b. Press [Enter] to start a new line with an automatic bullet.
c.c. Key Autograph session with Marsha Miles

4.4. Edit the text you keyed by following these steps:

a.a. Click the I-beam between the words “with” and “Marsha” to position
the insertion point.

b.b. Key aerobic video star and insert any necessary spaces.

5.5. Save the presentation as [your initials]1-24 in your Lesson 1 folder.

NOTE: When you print slides and handouts, colored backgrounds and
some graphics are not usually shown on the printout because they can

interfere with the legibility of the text. In a later lesson you learn how to control what
gets printed by using grayscale settings.

6.6. Print the slides full-size by following these steps:

a.a. From the File menu, choose Print.
b.b. In the Print what drop-down list box, choose Slides.
c.c. Click Preview.
d.d. Click the Next Page button to preview slide 2.
e.e. Click Print and then click OK.
f.f. Click Close to close the Preview window.

7.7. Close the presentation.

Lesson 1 ■ What Is PowerPoint? POWERPOINT 39

aExercise 1-24:
Objectives: 1, 3, 4, 7-8
Required Files: SpEvent1.ppt
Solution Files: Sol1-24 on Solutions CD-ROM

a
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Lesson Applications
E X E R C I S E 1- 2 5

Edit text, change presentation views, and save, print, and close a presentation.

1.1. Open the file Party1.

2.2. Using the Slide pane, make the changes to slides 2 and 3 as shown in
Figure 1-20.

3.3. Save the presentation as [your initials]1-25.

4.4. View each slide in the presentation.

5.5. Preview the presentation as handouts, 3 slides per page, grayscale, framed,
and then print it.

6.6. Close the presentation.

E X E R C I S E 1- 2 6

Edit text in Normal view and Slide view, run a slide show, and save, print, and close a
presentation.

1.1. Open the file JulyFun1.

40 POWERPOINT Unit 1

Assessment Resources:
• Solution Files on CD-ROM
• Test Bank on CD-ROM

A
S
S
E
S
S

Lesson Applications:
Provide independent practice for
students and may be used for
assessment. Objectives are indicated
for each exercise.

a

aExercise 1-25:
Objectives: 1-8
Required Files: Party1.ppt
Solution Files: Sol1-25 on Solutions CD-ROM

Entertainment

● Audition bands

● Charlie’s Dingbats

● The Electrolytes

● Wired Rabbits

● Contact Marsha Miles

● Is she willing to lead aerobics

● Is she available New Year’s Eve?

Menu

● Michele needs suggestions by November 1

● Staff party to be held December 2

● Menu printing deadline is December 10

FIGURE 1-20

Slide 3

Slide 2
Pure Power

dance-style ?

tasting 5

aExercise 1-26:
Objectives: 1-8
Required Files: JulyFun1.ppt
Solution Files: Sol1-26 on Solutions CD-ROM

a
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2.2. Move to slide 2. Change “am” in the first and second bullets to a.m. Change
the date in the last bullet to June 25.

3.3. Click the Outline tab and drag the Outline pane’s right border to make it wider.

4.4. Working on slide 3 in the outline area, change the age in the second bullet
from “21” to 18.

5.5. Save the presentation as [your initials]1-26.

6.6. Click the Slides tab and display slide 1. Run a slide show of the
presentation, clicking to display each new slide and text animation.

7.7. Preview and then print the presentation as handouts, 6 slides per page,
grayscale, framed.

8.8. Close the presentation.

E X E R C I S E 1- 2 7

Edit text, change presentation views, and save, print, and close a presentation.

1.1. Open the file DressCd2.

2.2. On slide 1, key the word Personnel to the left of “Training” so the title reads
“Personnel Training Session.”

3.3. Locate the last line of text on slide 2 (which begins “Under no
circumstances”). Position the insertion point at the end of that line and key
while on the job

4.4. Locate the last line of text on slide 3. Position the insertion point between
“Good 4 U” and “test” and key proficiency (the phrase should read
“Good 4 U proficiency test”).

5.5. Click the Outline tab and make the Outline pane wide enough to work
comfortably. Scroll down to display the outline text for slide 4.

6.6. Working on slide 4 in the Outline pane, delete the periods at the ends of the
two sentences that begin “Guests.”

7.7. Below the third bullet, change “Shirts are” to T-shirts will be

8.8. Save the presentation as [your initials]1-27.

9.9. Preview and then print the presentation as handouts, 4 slides per page,
grayscale, framed.

10.10. Close the presentation.

E X E R C I S E 1- 2 8 Challenge Yourself

Edit text, print a slide and handouts, and close a presentation.

1.1. Open the file RacePrep.

Lesson 1 POWERPOINT 41

a

aExercise 1-27:
Objectives: 1-5, 7-8
Required Files: DressCd2.ppt
Solution Files: Sol1-27 on Solutions CD-ROM

aExercise 1-28:
Objectives: 1, 3, 5-8
Required Files: RacePrep.ppt
Solution Files: Sol1-28 on Solutions CD-ROM

a
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2.2. Using whichever view you choose, edit slide 2 and slide 3 as shown in
Figure 1-21.

3.3. Save the presentation in your Lesson 1 folder as [your initials]1-28

4.4. View the presentation in Slide Sorter view.

5.5. Run a slide show of the presentation, beginning with slide 1.

6.6. Preview and then print all slides in grayscale, framed.

7.7. Print the presentation as handouts, 3 slides per page, grayscale, framed.

8.8. Close the presentation.

On Your Own

In these exercises you work on your own, as you would in a real-life work environ-
ment. Use the skills you’ve learned to accomplish the task—and be creative.

EXERCISE 1-29
Open the file SpEvent1. Change slide 2 so that its title is Summer Events. Edit the
slide’s bullets by changing the events to be for June and July, describing activities

42 POWERPOINT Unit 1

Entertainment

● The Electrolytes will be here for marathon eve, injecting mental

energy for all

● Julie will again lead her famous pre-marathon “Pump-you-up” chant

Pre Marathon

Carbo Loading Menu

● Marathon Angel

● A huge pile of angel hair with fat-free tomato sauce and sprinkled

with tiny bite-sized meat balls

● Bagel Bonanza

● Bagels brushed with a mixture of olive oil, garlic, and delicate

herbs

FIGURE 1-21

Slide 3

Slide 2

on charging up the runners

=

mountain pasta served

1

1This figure contains proofreading marks. You
might want to review “Proofreaders’ Marks”

with students from the Professional Approach Online
Learning Center at www.mhteched.com/pas.

On Your Own Exercises:
These exercises are entirely free-form. They do not
“hold the student’s hand” or provide steps. No solution
files are provided. Encourage students to be creative.
You might assign exercises as group projects.

aExercise 1-29:
Objectives: 1, 3, 5, 7-8
Required Files: SpEvent1.ppt
Solution Files: No solution file provided

a
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relating to summer sports such as swimming, softball, sand volleyball, or others.
Save the presentation as [your initials]1-29. Preview and then print the presenta-
tion as handouts, 2 slides per page.

EXERCISE 1-30
Open the file GoodFood. On slide 2, replace the text describing the pasta dishes
with pasta creations from your imagination. On slide 3, replace the text describing
the desserts with your own combination of sweet delights. Be sure the desserts
you describe use healthy ingredients.

Save the presentation as [your initials]1-30. Preview and then print the pre-
sentation as handouts, 3 slides per page.

EXERCISE 1-31
Open the file DressCd1. On slides 2 and 3, replace the text under the “Uniform”
bullet with a dress code you think would be appropriate for employees at the
Good 4 U restaurant in New York City as described in the Case Study. Replace the
second main bullet “Skates” with Hair and Nails and change the bullet under it to
talk about what kind of rules may apply to the way that the employees must wear
their hair and nails. On slide 4, upgrade the guest dress code to fit this restaurant
scenario. Save the presentation as [your initials]1-31. Preview and then print the
presentation as handouts, landscape orientation, 4 slides per page.

Lesson 1 POWERPOINT 43

a

a

aExercise 1-30:
Objectives: 1, 3, 5, 7-8
Required Files: GoodFood.ppt
Solution Files: No solution file provided

aExercise 1-31:
Objectives: 1, 3, 5, 7-8
Required Files: DressCd1.ppt
Solution Files: No solution file provided
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